
 

  

            PowerTeacher Pro Reference Guide 
 

Accessing the Gradebook  
Navigate the gradebook directly through the teacher portal. There’s 
no need to launch a separate application to access the gradebook. 
The first time you navigate to the gradebook, you’ll see a welcome 
message that introduces some of the features.   

To navigate to the gradebook:   

 

1. Enter the URL of the PowerSchool server followed by  
/teachers  

2. Enter your username and password  

3. Click Sign In  

4. On the Start Page, click PowerTeacher Pro  

5. Read the welcome message and click Close  
  

Customizing Class Names and Adding Class 
Descriptions  
Customize the name of the class if you prefer to use a name that is 
different from the course name. For example, if you teach multiple 
Biology classes, customize the names to be different from each 
other. Custom class names will appear only in your gradebook. To 
customize a class name and add a description:  

1. At the top of the gradebook window, select a class  

2. In the upper-right corner, select the term in which the class 
meets, if different from the current term, or select all terms  

3. Click Settings  

4. Select Class Descriptions  
  
The details pane for the selected class opens.  

5. To customize the name of the class, enter the name in the  
Custom Class Name field  
  
Once you click Save, the custom class name will appear in 
the gradebook automatically.  

6. Enter the class description, syllabus, or other details in the  
Class Description field  
  
Use the editing bar to style the description.  

7. Click the arrow to the left of another class name to open the 
details pane and add a custom name or description  

8. Click Save  

  



  

Setting Up Display Preferences  
Customize the display settings to control how class names appear 
in your gradebook—by period and day or by section number.  

To set up display preferences:  

1. Click Settings  

2. Select Display Settings  

3. Open the "Display and Sorting" menu and select an option, 
such as Section Number (sort by Course/Custom  
Name), to change the way class names appear   
  
When you choose to sort class names by course name or 
custom name, classes will be sorted by their course names, 
unless you've entered custom class names on the Class 
Descriptions page. In that case, classes will be sorted by 
their custom names.  

4. Check Show Traditional Grades to display traditional 
grades in the gradebook  

5. Then from the “Values to Show in the Traditional Grade 
Column” menu, select the types of grades you want to see, 
such as Grade, Percent, and Points  

6. Check Show Standards Pages and Links to use the 
standards grading features in the gradebook  

7. Check Show Standards on Assignments to show 
standards aligned to assignments in the gradebook  

8. To make the auto-calculation of standards scores from 
assignments scores the default setting when you create a 
new assignment, choose New Assignments Start 
Checked from the “Auto-Calculate Assignment Standards  
Scores Initial State” menu  
Making this selection will cause the “Auto-Calculate 
Assignments Standards Scores” check box to be selected by  

default when you create an assignment. To view the setting 
when creating a new assignment, navigate to the Standards 

tab, select the standards that are aligned to the 
assignment, and click the Show Selected Standards tab.  

9. To change the sort order of the Traditional and Standards 
navigation links in the Grading menu and Quick Menu, open 
the Navigation Links Sort Order menu and choose  
Standards, Traditional  
  
The default setting is Traditional, Standards.  

10. To display the Professional Judgment Indicator on the  
Standards and Standards Progress pages, check Show on  
Grading: Standards and Show on Students: Standards 
Progress  

11. Under Student Names, use the Display menu to define how 
students’ names will appear in the gradebook, such as by 
first, then last name  

12. Use the “Sort Students by” menu to choose how to sort the 
lists of students, such as by first name  

13. To view new students’ names at the bottom of class lists, 
check Add newly enrolled students to the bottom  

14. To conceal the names of pre-registered students from class 
lists, check Hide pre-registered students  

15. Click Save  

 
 
 
 
 
 

 
 

 
 



  

Setting Up Grading Preferences  
To define a traditional grade calculation for a class:  

1. Click Settings  

2. Select Traditional Grade Calculations  

3. To see the grade calculations for all of the classes, click 
Expand All  

4. For one of the classes in the list, click the Edit icon next to 
the first reporting term  

5. To calculate the overall class grade using the formula, verify 
that Calculate Overall Class Grade is checked  

6. Open the Type menu and choose a calculation type, such as 
Category Weighting  

7. Open the Attribute menu and select a category, such as  
Homework  

8. To define the weight of the selected category, enter a value 
in the Weight field, such as 2 (for 20%)  

9. To include another category, click the + sign  

10. Open the Type menu and choose Category Weighting  

11. Open the Attribute menu and select a different category, 
such as Quiz  

12. To define the weight of the selected category, enter a value 
in the Weight field, such as 3 (for 30%)  

13. Repeat steps 9-12 to set up weighting for two more 
categories  
  

14. To see the grade calculations for all of the classes, click 
Expand All  

15. For one of the classes in the list, click the Edit icon next to 
the first reporting term  

16. To calculate the overall class grade using the formula, verify 
that Calculate Overall Class Grade is checked  

17. Open the Type menu and choose a calculation type, such as 
Category Weighting  

18. Open the Attribute menu and select a category, such as  
Homework  

19. To define the weight of the selected category, enter a value 
in the Weight field, such as 2 (for 20%)  

20. To include another category, click the + sign  

21. Open the Type menu and choose Category Weighting  

22. Open the Attribute menu and select a different category, 
such as Quiz  

23. To define the weight of the selected category, enter a value 
in the Weight field, such as 3 (for 30%) 

24. Repeat steps 9-12 to set up weighting for two more 
categories Use weight values that will make the values in 
the Percent columns add up to 100%.  
 

25. To save the grade calculation, click Save 



  
  

 

To copy traditional final grade calculations:  

1. Click Settings  

2. Select Traditional Grade Calculations  

3. In the upper-right corner of the Traditional Grade 
Calculations page, click the gear icon  

4. Select Copy Traditional Grade Calculations  

5. At the top of the Copy Final Grade Calculations window, 
select Within A Class to copy the settings from one 
reporting term to another within the same class  

6. In the From area, open the Class menu and choose the class 
from which you want to copy the calculations  

7. In the From area, open the Reporting Term menu and choose 
S1 as the term from which you want to copy the calculations  

8. In the To area, open the Reporting Term menu and choose  
S2 as the term to which you want to copy the calculations  
  

9. Click Validate copy  

10. Review the summary to ensure that you are copying the 
correct settings, then click Copy  
  
The alert at the top of the window indicates that the settings 
were copied successfully.  

Working with Assignments  
Before you begin creating assignments, it’s recommended that you 
create categories so you can group assignments by type.  

Creating Categories  
Categories are broad classifications in which you group similar 
types of assignments. Examples of categories are homework, 
tests, and quizzes.  

  
To create an assignment category:  

1. Click Create  

2. Select Category  

3. On the Category tab, open the Select Classes menu and 
select the class or classes in which you will use the category  

          By default, the category is available to all classes.  
4. Enter the name of the category, such as Test  

5. Select a color for the category, such as Red  

6. Use the default status of Active  
  
Check Inactive when you want to make categories that you 
no longer use inactive.  

7. Enter a description of the category, such as Use for test 
assignments  

8. Click the Assignment Defaults tab  

9. Select the default score type that assignments in this 
category will use, such as Points  

10. To include extra points in the assignments by default, click  
Extra Points and enter the number of extra points, such as  



  
  

 

11. To weight assignments in this category by default, click  
Weight and enter a value, such as 2, in the Weight field  

12. In the Score Entry Points field, enter the number of points 
that assignments in this category will be worth by default, 
such as 100  

13. Use the Publish Assignment menu to define when 
assignments in this category will be published  

14. To publish the scores of assignments in this category by 
default, verify that Publish Scores is selected  

15. To include assignments in this category in final grade 
calculations by default, verify that Count in Final Grade is 
selected  

16. To save the new category, click Save  

Creating and Viewing Assignments  
View assignments on both the Assignments and Scoresheet pages. 
Set up assignments at the beginning of a school term or at any 
time during the term. To save time, duplicate existing assignments 
or create duplicates while creating a new assignment.  

To create an assignment:  

1. Click Create  

2. Select Assignment  

3. Open the Select Classes menu and select a class  
  
Click outside the Select Classes menu to close it.  

4. Enter the name of the assignment, such as Unit 1 Test  

5. Select Test as the category  

6. Select a score type, such as Points  

7. Enter the number of score entry points, such as 80  

8. To include the assignment in students’ final grades, verify 
that Count in Final Grade is selected  

9. Enter the assignment due date  
  
The default due date is today’s date.  

10. Enter a description, such as This test covers all of the 
topics in Unit 1  

11. Click the Students tab  

12. Verify that the assignment applies to all students  
To apply the assignment to a selection of students, click 
Add/Remove Students. Then clear the check box next to 
the Filter area and check the boxes next to the selected 
students’ names.  

13. Click the Standards tab  

14. Select the standards that are aligned to the assignment  

15. Click the Publish tab  

16. Open the Publish Assignment menu and choose when to 
publish the assignment for students and parents  

17. To publish students’ scores once you’ve scored the 
assignment, check Publish Scores  

18. Click Save and Close at the bottom of the Create window  
  
Instead of closing the edit window, you could also copy the 
assignment by clicking Duplicate at the bottom of the 
Create window.  
  
Score the new assignment immediately by clicking Score 
Assignment in the alert at the top of the window.  

  

  



  

   

To duplicate an assignment for use in another class:  

1. Click Grading  

2. Select Assignment List  

3. In the list of assignments, locate an assignment that you’ve 
already created and click the Edit icon  

4. Click Duplicate at the bottom of the Edit window  

5. Open the Select Classes menu, clear the check box next to 
the currently selected class, and choose a different class  
  
Click outside the Select Classes menu to close it.  

6. Edit the duplicated assignment name by deleting the 
underscore and number that were appended to the end  

7. Use the same category, score type, score entry points, due 
date, description, and publication settings as the original 
assignment, or modify the values as needed  

8. Click the Standards tab  

9. Click Add/Edit Standards and, if needed, select a new set 
of standards that are aligned to this assignment  

10. To save the assignment and close the Edit window, click 
Save and Close  

11. To verify that you copied the assignment to a different class, 
click the name of the currently selected class in the 
navigation bar at the top of the page and select the class that 
you copied the assignment to  

12. Locate the duplicated assignment in the list of assignments  

Copying Assignments  
PowerTeacher Pro assignments in a selected term and class to other 
terms and classes using the Copy Assignments feature. Use the 
existing due dates, a custom due date, or proportional due dates 
relative to the selected term.  

To copy assignments from a Semester 1 class to a Semester 2 
class:  

1. From the Assignments or Scoresheet pages, click the gear 
icon to the left of the Term menu  

2. Click Copy Assignments  

3. Under From, open the Term menu and select Semester 1  

4. Under From, open the Class menu and select the class from 
which you want to copy the assignments  

5. Under To, open the Term menu and select Semester 2  

6. Under To, open the Classes menu and select the class or 
classes to which you want to copy the assignments  

7. Under Copy Options, open the Due Dates menu and choose 
whether you want to use existing, relational, or custom due 
dates  

8. Under Choose the Assignments, check the box to the left of 
the Category heading to select all of the assignments, or 
check individual boxes next to the assignment names to 
choose a smaller selection  
  
If the source class you selected is a PowerTeacher Gradebook 
class, all assignments will be copied to the classes you 
select.  

9. To complete the process, click Copy Assignments  
 Be sure to edit the due dates of the copied assignments. 
 
 
 
 
 



  
  

 

Working with Grades  
When entering scores, make sure to use the type of score that you 
set up when you created the assignment. For example, use numbers 
for points and percentages or letters for letter grades.  

To enter scores:  

1. Click Grading  

2. Click Assignment List or Scoresheet  

From the Assignments or Scoresheet pages, enter a student’s 
assignment score by clicking in the cell where the student’s name 
intersects with the assignment name and type in the score  

Navigate sideways through the score columns by clicking the blue 
columns with left- or right-facing arrows at the end of the rows.  

View the summary above the list of assignments to see the selected 
assignment’s score type, as well as the student’s existing score (if 
the assignment was previously scored), and the due date  

In the summary, click Edit Assignment to edit the assignment 
details. Click Show More to view additional information, such as the 
associated grade and special codes scales.  

  



  

  

Using the Score Inspector and Flags  
While you can enter scores manually, use the Score Inspector to 
provide more details about the student’s performance, such as 
when a student has a missing or late assignment. Also use the 
Score Inspector to enter a comment about a student’s score.   

To open the Score Inspector, click in a score cell on the 
Assignments or Scoresheet pages.   

The following table provides brief explanations of the flags (score 
indicators) and other icons available in the gradebook.  

 

  

  

 
 

 

 

 

 

 

 

 

 
 

 

 

 

 
 

  
 Flag or Icon  Description  

  

Indicates that an assignment was collected   

  

Indicates that an assignment is late  

  

Indicates that an assignment is missing  

  

Indicates that an assignment is exempt  

  

Indicates that an assignment wasn’t completed 
due to the student being absent  

  

Indicates that an assignment is incomplete  

  

Indicates that a comment was added  

  

Indicates that evidence exists for mastery that 
may differ from a student’s calculated standard 
score  



  

  

Filling Scores  Use the Fill functions to either fill scores for one 
assignment for all of the students in a class, or to fill all 
assignment scores for one student. Scores will be filled in cells that 
do not already have scores. Additionally, use the fill scores 
functions to fill comments.  

To fill students’ scores for one assignment:  

1. For the selected assignment, click in a score cell on the 
Assignments or Scoresheet pages  

2. Enter the score or select the flag in the Score Inspector  

3. Click the Fill icon with the vertical arrows  

4. Save the scores  

To fill multiple assignment scores for one student:  

1. For the selected student, click in a score cell on the 
Assignments or Scoresheet pages  

2. Enter the score or select the flag in the Score Inspector  

3. Click the Fill icon with the horizontal arrows  

4. Save the scores  

Your favorite comments will appear at the top of the list of 
comments in the Score Inspector.  

Scoring Assignments  
Use one of two methods to score an assignment—score a single 
assignment from the Assignments page, or score multiple 
assignments on the Scoresheet.  

To enter scores, flags, or comments for a single assignment:  

1. Click Grading  

2. Select Assignment List  

3. Click the name of an assignment  

4. Click in a student’s score cell and type a score, such as 72  

  
View the assignment summary above the list of students to 
see which score type to use.  

5. Click the right-facing Score arrow in the Score Inspector to 
move to a standards score cell (if standards are aligned to 
the assignment)  

6. Enter a standards score for the student  
  
View the assignment summary above the list of students to 
see which grade scale type to use. Hover your cursor over 
a standard identifier to view the name and description of 
the standard.  

7. Save the scores  

To enter scores, flags, or comments for one or more assignments 
on the Scoresheet:  

1. Click Grading  

2. Select Scoresheet  

3. Click in a student’s blank score cell for the selected 
assignment and enter a score in the Score Inspector  

4. Click the vertical Fill icon to fill all of the blank score cells 
with the score you entered in the Score Inspector  

5. In the alert window that lists the number of scores that 
were filled, click Ok  

6. Click in a different student’s score cell for a different 
assignment and click the Exempt flag  

7. Click Save  

 



  

  

Submitting Final Grades  
At the end of the term, notify your school’s PowerSchool 
administrator that you have finished entering the scores for the 
term and that final grades are ready to be stored.  

1. Select a class and verify that you are in the correct term  

2. Click Grading  

3. Select Traditional  
  
Or select Standards or Comment Verification.  

4. At the bottom of the page, click Final Grade Status  

5. When you have completed your final grades, check [Term] 
Final Grades are Complete  

6. Enter a comment indicating that final grades are complete, 
and click Save  
  
The green check mark next to "Final Grade Status" 
indicates that final grades are complete.  
  

  
  
If you aren’t done with final grades yet, leave the check 
box clear, enter a status comment, and click Save. 

 

 
 
 
 
 
 
 
 
 
 

 
 

 

 

 
 

 

 

 

 

 

 

 

 

 

 



  

  

Running PowerTeacher Pro Reports  
The gradebook contains reports that you can view onscreen or  
print. Personalize each report by entering a custom title or by  
including a top note, bottom note, or signature line. The 
following table provides brief descriptions of the reports:  

Report Name  Description  

Individual Student 
Report  

• Use this report to view or print a 
summary of the class activity per 
student  

• Include only one class or the 
student's full schedule  

• Include student numbers next to 
student names for identification 
purposes  

• Present a summary of student 
work to parents at conferences or 
to a principal during a review, or 
use the report as a midterm 
update for students and parents  

• Choose whether or not to include 
course grades and attendance, 
assignments, category totals, 
standards scores, citizenship 
scores, and comments  

• Print the report for a few students 
or a group  

 

 

 

 

 

Report Name  Description  

Multi-Function  
Assignment Report  

• Use this report to view or print a 
list of students and scores per 
assignment  

• Use it to find missing, late, or 
incomplete assignments, to help 
students and parents keep up with 
class work, to target students who 
need extra help, or to gauge which 
assignments present the most 
challenges to students  

Report Name  Description  

Student Roster  • Use this report to view or print 
demographic information by class  

• Use the report, for example, to 
keep track of money collected for 
classroom field trips, or as an 
emergency contact list  

• Customize the report by adding 
blank columns (the report 
remembers the information you 
entered last)  

• Use the Order arrows to arrange 
the columns in any order  

• Run the report as a PDF or an 
Excel spreadsheet  



  

  

To run the Individual Student Report: To run the Individual Student 
Report:  

1. Click Reports  

2. Select Individual Student Report  

3. Enter a report title, such as Progress Report  

4. Open the Select Classes menu and choose the classes to 
include on the report  

5. Click Reports  

6. Select Individual Student Report  

7. Enter a report title, such as Progress Report  

8. Open the Select Classes menu and choose the classes to 
include on the report  

9. To use a previously customized class name, check Use 
Custom Class Name  

10. Since you are creating a progress report that includes 
students' course grades in only your class instead of all of 
their classes, leave the "Include Students' Full Schedules" 
check box clear  
  
Check Include Students' Full Schedules to create a 
multi-section report.  

11. In the Sort Options section, open the Layout menu and 
choose By Section, By Student  

12. To sort the report by students’ last names, open the 
Students menu and choose Last Name   
  
To use the preference for how student names are sorted by 
default in your gradebook that you defined under Settings > 
Display Settings, choose Gradebook Preference.  

13. Use the Assignments menu to sort the assignments by due 
date or by category and due date  

14. Open the Areas To Include menu and check Course 
Grade Comments and Assignment Comments to 
include any comments that you’ve entered about the 
students in the report   

  
"Course Grades and Attendance," Assignments, and 
Category Totals are checked by default. If citizenship score 
entry is enabled, select Citizenship to include citizenship 
scores.  

15. Click the Areas To Include menu again to close it  

16. Verify that Show Percentages is selected to include 
students’ grade percentages in the report  

17. To help with identifying students with the same name, 
add student numbers to the report by selecting Include 
Student Number with Student Name  

18. To include students’ grades from the current term, use 
the default settings under Date Range   

19. Use the default settings under Data Filters to include 
any assignments, any scores, any category, and any 
course grades   

20. Open the Students tab  

21. To run the report for a selection of students rather than 
for all of the students in the classes, click 
Add/Remove Students  

22. All of the students are selected by default, so clear the 
check box to the right of the Filter area, then in the list 
of students, check the boxes next to individual student’s 
names  

23. Scroll to the top of the page and click the Format tab  

24. Since you are including all of the available data in the 
report, leave the page orientation set to Landscape to 
make the text easier to read  



  

  

25. Use the default option PDF for the report output  

26. To create a page break between students, check Page 
Break  

27. Choose to exclude row shading to save ink during printing  

28. Leave the “Include” check box clear for the Top Note option, 
since you don’t plan to include a note at the top of the 
report  

29. Leave the “Include” check box clear for the Bottom Note 
option, since you don’t plan to include a note at the bottom 
of the report  

30. Clear the Signature Line check box, since you don’t need 
parents to sign the report   

31. To generate the report, click Run Report  
  
An alert at the top of the window indicates when the report 
is being processed and when it is complete.  

32. To open the Report Queue, click the Notification icon—which 
has a red number indicating the number of reports that are 
ready—and then select Report Queue  

33. If the report is still running, click Refresh to update the 
status  

34. To download the completed report, click the report name 

 

To run the Student Roster report for a class:  
1. Open the menu at the top of the gradebook window and 

select a class  

2. Click Reports  

3. Select Student Roster  

4. Enter a report title, such as Field Trip Roster  

5. Since you selected a class before you navigated to the  
Reports menu, it is already selected for the Classes 
option  

6. To sort the roster of students by last name, open the 
Students menu and choose Last Name  

7. Add columns of student information by opening the Add  
Columns menu and clicking Add next to Gender and 
Grade Level  

8. Click Add next to Blank twice to include a column for 
taking attendance and one for tracking participation   
  
A column titled “Name” is included by default to list the 
students’ names.  

9. Click the Add Columns menu again to close it  

10. Enter Attendance as the title of the first blank column  

11. Enter Participation as the title of the second blank 
column   

12. Click the Students tab at the top of the page and verify 
that the report applies to all of the students in the 
selected class  

13. Scroll to the top of the page and click the Format tab  

14. Open the Orientation menu and choose Portrait   

15. Use the default option PDF for the report output  
  



  

  

To work with the data in a spreadsheet, choose Excel.   

16. Use the default settings for the rest of the format options  

17. To generate the report, click Run Report  
  
An alert at the top of the window indicates when the report 
is being processed and when it is complete.  

18. To open the Report Queue, click the Notification icon and 
then select Report Queue  

19. If the report is still running, click Refresh to update the 
status  

20. To download the completed report, click the report name 

   


